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Violation of the homogeneity of regression slopes
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Abstract Aptitude-treatment interaction (ATI) effects are present when individuals demonstrate

differential outcomes across treatments based upon aptitude—that is, any measurable individual

characteristic, attribute, or ability (e.g., anxiety, learning style, motivation, prior knowledge). ATI

effects may exist in data from one design commonly used in psychological and educational re-

search—the two-group pre-post design—in which pre-intervention scores may be considered to

reflect individual aptitude. Researchers may mistakenly overlook these effects, however, due to in-

appropriate analytical approaches. When applying analysis of covariance (ANCOVA), it is important

to check for ANCOVA assumptions, including an assumption known as homogeneity of regression

slopes. When heterogeneity of regression slopes is found, ATI effects are revealed. Consequently,

alternative approaches to ANCOVA must be sought. Using formulae based on the Johnson-Neyman

procedure to define simultaneous regions of significance is one straightforward alternative. This tu-

torial outlines the process for analyzing data resulting from two-group pre-post studies when data

violate the ANCOVA assumption of homogeneity of regression slopes. What was initially viewed

as an obstacle may result in the discovery of an ATI effect, which may be described statistically

through simple mathematical calculations.

Keywords Aptitude-treatment interaction effects; two-group pre-post designs; ANCOVA; Johnson-

Neyman procedure. Tools SPSS.

� Teresa.Johnson@jhmi.edu

TRJ: 0000-0001-7468-6947
10.20982/tqmp.12.3.p253

Acting Editor De-

nis Cousineau (Uni-
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Introduction
Pre-post designs are used extensively in psychological and

educational research to assess changes in outcomes be-

tween two time points and/or to compare outcomes of in-

dependent groups. Of particular interest here, are two-

group pre-post designs. While these research designs may

seem straightforward, analysis of data resulting from such

studies often presents great challenges (e.g., Lord, 1967).

Common analytical approaches for examining data

from two-group pre-post designs include (1) indepen-

dent samples t-test on gain or difference scores, (2)

mixed model analysis of variance (ANOVA), often called

repeated-measures analysis of variance (RM-ANOVA) with

a between-subjects factor, and (3) analysis of covariance

(ANCOVA). When choosing an approach, it is important to

understand the strengths, limitations, and requirements

of each method; generally speaking, however, ANCOVA is

usually the preferred approach (Bonate, 2000; Dimitrov &

Rumrill, 2003; Dugard & Todman, 1995; Huck & McLean,

1975; Knapp & Schafer, 2009; Overall, 1993; Senn, 1994).

This tutorial provides guidance for students and re-

searchers who originally planned to use ANCOVA for the

analysis of data arising from two-group pre-post studies,

who exercised due diligence in checking to see if the data

met assumptions required for ANCOVA, and who now find

themselves at an impasse because the data violated an as-

sumption of ANCOVA known as homogeneity of regression
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slopes. For those with little to moderate training in statis-

tics and/or who are consulting textbooks for guidance, the

coursework and text likely concluded with the directive

that ANCOVA should not be employed under these circum-

stances. What are proposed solutions, then? Fortunately,

what was initially viewed as an obstacle may result in the

discovery of what is known as an aptitude-treatment inter-

action (ATI) effect. Moreover, ATI effects may be described

statistically through a series of simple mathematical calcu-

lations. Example analyses and results are presented using

SPSS 23.0 (IBM; Armonk, NY); figures depicting scatterplots

were created using Excel 2013. This tutorial assumes that

the reader has a basic understanding of the use of SPSS.

Understand ATI effects and the importance of their
identification
ATI effects are present when individuals demonstrate dif-

ferential performance across treatments based upon apti-

tude. “Performance” refers to a measurable outcome of

interest, “treatment” represents a manipulated exposure

variable (e.g., psychological or educational intervention),

and “aptitude” denotes a measurable learner characteris-

tic, attribute, or ability (e.g., anxiety, learning style, moti-

vation, prior knowledge).

For example, consider a hypothetical investigation of

learners’ scores on an achievement test (performance) fol-

lowing participation in either a high- or low-structure ed-

ucational intervention (treatment) based upon learners’

scores on a measure of trait anxiety (aptitude). An in-

teraction would be observed if low-anxiety learners per-

formed better on the test following participation in low-

structure education as compared to high-structure educa-

tion, whereas high-anxiety learners performed better on

the test following participation in high-structure educa-

tion as compared to low-structure education. In this sce-

nario, the optimal level of structure to define in the edu-

cational environment for achieving the outcome goals de-

pends upon (or interacts with) a learner’s level of trait anx-

iety. The concept of ATI effects aligns well with other ar-

eas of focus in psychological and educational research and

practice, such as theories of multiple intelligences, individ-

ual differences, motivation, differentiated instruction, and

learning style.

ATI effects were recognized as points of inquiry in the

field of psychology several decades ago (Cronbach, 1957),

although some methods for identifying and handling these

types of interactions were proposed as early as the 1930s

(e.g., P. O. Johnson & Neyman, 1936; also see Cronbach &

Snow, 1969). Resources for expanding one’s understand-

ing of ATI effects, including their history and significance,

and for conducting ATI research are widely accessible

(e.g., Bracht, 1970; Cronbach & Snow, 1969; Driscoll, 1987;

Snow, 1989, 1991; Snow, Federico, & Montague, 1980), and

are recommended as a first step toward identifying and

handling ATI effects in one’s own research. The impor-

tance to researchers and educators is apparent because,

“In general, unless one treatment is clearly best for ev-

eryone, treatments should be differentiated in such a way

as to maximize their interactions with aptitude variables”

(Cronbach, 1957, p. 681). ATI research helps us to discover

how this differentiation should be approached.

Although the steps in this tutorial are intentionally sit-

uated within the context of the two-group pre-post design,

note that research studies may be designed a priori specif-
ically to detect ATI effects, and may examine numerous

treatments, outcomes, and aptitudes (e.g., Abelson, 1953;

P. O. Johnson & Hoyt, 1947; Karpman, 1983; Potthoff, 1964).

Check formissing data, outliers, and basic assumptions
As with all ANOVA models, data must first be screened

to assess the degree to which there are any missing data

and/or outliers, and to confirm that data meet basic as-

sumptions of ANOVA, including normality and homogene-

ity of variance. Statistics textbooks that address ANOVA

models are great resources for furthering one’s under-

standing of these initial exploratory steps and for assisting

in making decisions related to handling missing data, out-

liers, non-normality, and heterogeneity of variance (e.g.,

Roberts & Russo, 1999; Tabachnick & Fidell, 2012; Turner &

Thayer, 2001). Additionally, numerous resources are avail-

able to students and researchers that provide step-by-step

instructions for creating boxplots, frequency distributions,

and other graphical displays of data, conducting statistical

tests of assumptions (e.g., Shapiro-Wilk’s test of normality;

Levene’s test of homogeneity of variance), and performing

other related tasks in a statistical analysis program (e.g.,

Cunningham & Aldrich, 2011; Field, 2013, for SPSS 18.0

and SPSS 20.0-21.0 respectively). Let’s assume here that

missing data and outliers are either non-existent or are

handled appropriately, and that assumptions of normal-

ity and homogeneity of variance are either met or the re-

searcher considers ANCOVA to be robust to slight violations

here. ANCOVA models, in particular, have two additional

assumptions that must be met—linearity and homogeneity

of regression slopes. Due to the distinct roles they play in

ANCOVAmodels, these assumptions are addressed individ-

ually in the next two sections.

View scatterplots and check for linearity
Following ANCOVA models and their application to two-

group pre-post designs, treat post-test score as the depen-

dent variable (y), treatment group as the independent vari-
able (or between-subjects factor; using “Treatment 1” and

“Treatment 2” to denote groups), and pre-test score as the
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Table 1 Hypothetical Data Set for Two-Group Pre-Post Design, Including Squared Pre-Test Scores and Summary Statistics

(N = 40)

Pre-Test (x) Pre-Test Squared (x2) Post-Test (y)
Treatment 1 Treatment 2 Treatment 1 Treatment 2 Treatment 1 Treatment 2

(n1 = 20) (n2 = 20) (n1 = 20) (n2 = 20) (n1 = 20) (n2 = 20)
20 25 400 625 49 78

26 26 676 676 54 84

32 32 1024 1024 51 77

37 36 1369 1296 63 81

41 45 1681 2025 61 82

42 46 1764 2116 74 87

44 46 1936 2116 67 84

47 49 2209 2401 70 89

47 51 2209 2601 72 89

52 55 2704 3025 74 86

54 55 2916 3025 85 84

54 59 2916 3481 81 86

57 62 3249 3844 73 82

61 63 3721 3969 90 86

65 67 4225 4489 97 85

68 68 4624 4624 95 83

68 71 4624 5041 97 85

70 72 4900 5184 98 87

75 76 5625 5776 100 83

79 82 6241 6724 99 86

x̄1 = 51.95 x̄2 = 54.30
∑
x21 = 59013

∑
x22 = 64062 ȳ1 = 77.50 ȳ2 = 84.20

SDx1
= 16.28 SDx2

= 16.37 SDy1 = 16.97 SDy2 = 3.16

covariate (x). A hypothetical data set of 40 scores is pro-
vided in Table 1 to facilitate a fully-worked concrete exam-

ple across the remaining steps. A screenshot of the data

arranged in SPSS appears in Figure 1. Scores were defined

deliberately to emphasize patterns and outcomes, and are

ordered in the table from low to high based on pre-test

score for ease of review.

ANCOVA assumes linearity—that is, that there is a

straight-line relationship between the covariate and de-

pendent variable. Inspection of bivariate scatterplots is ap-

propriate for fundamental assessment of linearity (resid-

uals plots may be used for additional diagnoses). Pre-

and post-test scores in the hypothetical data set, indeed,

demonstrate a linear relationship, as shown in Figure 2,

Panel (A); as such, Pearson’s r may be used to describe
the magnitude of this relationship. The correlation here

is 0.72, which is significantly different than 0 (p < 0.001).
However, a scatterplot depicting a single regression line

for the entire sample may mask additional characteristics

of the data.

To explore further and to prepare for testing the ho-

mogeneity of regression slopes assumption, construct the

scatterplot to depict regression lines for each treatment, as

shown in Figure 2, Panel (B). Linear relationships are ob-

served here for both treatments (r = 0.96, p < 0.001 for
Treatment 1; r = 0.46, p = 0.04 for Treatment 2); how-
ever, the slopes (angles) of the lines appear very different.

The fact that the lines are not parallel indicates an interac-

tion; moreover, the fact that the lines cross signifies what is

known as a disordinal interaction, wherein the superiority

of one treatment over the other is not constant across the

full range of pre-test scores (Aiken & West, 1991; Cronbach

& Snow, 1981; Lubin, 1961).

Although a researcher would construct the two-group

scatterplot for the purposes of testing homogeneity of re-

gression slopes anyway, note that careful examination of

these hypothetical data at earlier stages should have al-

ready caught the researcher’s attention. Standard devia-

tion (SD) for pre-test scores between treatments is nearly

identical (16.3 vs. 16.4), but the discrepancy in SD for post-

test scores between treatments is marked (16.9 vs. 3.2;

which, incidentally, resulted in a violation of homogeneity

of variance; Levene’s test, p < 0.001). The significantly
smaller variation in post-test scores for Treatment 2 im-

plies that the regression line for that group would be com-

paratively flatter (i.e., relative to the x-axis) than the re-
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Figure 1 Screenshot of the hypothetical data set for a two-group pre-post design in SPSS 23.0 (N = 40).

gression line for Treatment 1 (note that if all students in

Treatment 2 achieved the same post-test score, where SD =

0, all points would lie perfectly on a straight flat line paral-

lel to the x-axis).

Check for homogeneity of regression slopes
At this point, an examination of the raw data set and re-

lated descriptive statistics, and observation of the non-

parallel, crossing lines in the two-group scatterplot suggest

the presence of an ATI effect and possibly render ANCOVA

an inappropriate analytical approach. However, the extent

to which the lines are non-parallel needs to be formally

tested as a check for homogeneity of regression slopes.

To test whether or not the slopes of the regression lines

for the two groups are equal, enter all terms into a uni-

variate general linear model—that is, enter the indepen-

dent variable (treatment), the covariate (pre-test score),

and an independent variable-by-covariate (treatment-by-

pre-test score) interaction term, using post-test score as the

dependent variable. There are twoways to accomplish this

from an analysis standpoint. SPSS, for example, performs

this test under Analyze >General Linear Model>Univariate,

provided the researcher specifies a custom model to force

the inclusion of all three terms, as follows:

1. Move PostTest_Score to the “Dependent Variable”
box, move Treatment_Group to the “Fixed Fac-
tor(s)” box, and move PreTest_Score to the “Co-
variate(s)” box;

2. Click the “Model” button;

3. Select the “Custom” radio button;

4. Ensure that the “Build Term(s)” type displays “In-

teraction” (as this is the default when accessing

this dialog box for the first time), highlight both

Treatment_Group and PreTest_Score, and
move the two variables over to the “Model” window;

5. Change the “Build Term(s)” type to “Main ef-

fects,” highlight both Treatment_Group and

PreTest_Score, and move the two variables over
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Figure 2 Two pre-/post-test score scatterplots. Panel (A) shows the pre-/post-test score scatterplot for all participants

(N = 40), and Panel (B) shows the pre-/post-test score scatterplot for participants by treatment (n1 = 20; n2 = 20).

to the “Model” window;

6. Click “Continue,” and then click “OK.”

Figure 3 shows the two relevant dialog boxes in SPSS

properly filled.

The test may also be conducted through linear regres-

sion analysis in SPSS (i.e., Analyze>Regression>Linear),

provided the researcher first creates a new variable—the

treatment-by-pre-test score interaction term—for in-

clusion in the model (e.g., Transform>Compute Vari-

able; name the new “Target Variable,” and define

Treatment_Group*PreTest_Score as the “Numeric
Expression”).

If the p-value corresponding to the interaction term is
less than the pre-specified Type I error rate (e.g., α = 0.05),
then the slopes are considered non-equivalent and the ho-

mogeneity of regression slopes assumption of ANCOVA is

violated. Tables 2 and 3 display results derived from SPSS

using the hypothetical data set, and testing redundantly

for homogeneity of regression slopes through the SPSS

general linear model and regression approaches, respec-

tively. The two approaches are formally identical—t2 =
11.952 = 142.80 is the same as F = 142.64, rounding
errors notwithstanding. Either analysis formally confirms

the presence of a significant ATI effect for this hypotheti-

cal data set, and necessitates an alternative analytical ap-

proach.

Identify an alternative analytical approach
The presence of an interaction effect suggests that treat-

ment effects are not the same across various levels of the

co-variate or aptitude. Proceeding with ANCOVA, despite

heterogeneity of regression slopes, may lead researchers

to erroneously conclude that performance did not differ

significantly by treatment. Consequently, alternative ana-

lytical approaches must be considered, which may include

the Johnson-Neyman procedure (Fraas & Newman, 1997;

Karpman, 1983; Kowalski, Schneiderman, & Willis, 1994;

Rogosa, 1981) and extensions thereof, such as that pro-

posed by Potthoff (1964). For the sake of simplicity, let’s

consider formulae constructed by Potthoff (1964) as amod-

ification to the Johnson-Neyman procedure (Aiken & West,

1991; D’Alonzo, 2004; Pedhazur & Schmelkin, 1991; Rogosa,

1981). These formulae allow for calculations of the point

of intersection (crossover point) of regression lines, and

what are known as simultaneous regions of significance

(SROS). Potthoff (1964) explains that a “simultaneous” re-

gion of significance is a region that “with confidence ≥ 95
percent (for α = .05), we can state that the two groups
[...]are different simultaneously for all points contained in

it” (p. 244). Regarding the hypothetical data set, SROS may

be calculated to identify the pre-test score ranges for which

treatments differ significantly on the post-test. The pur-

pose of this alternative approach is to obtain values asso-

ciated with two SROS (R′
)—one region wherein post-test

scores for Treatment 1 are significantly higher than post-
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Figure 3 Screenshots of dialog boxes for testing the homogeneity of regression slopes assumption in SPSS 23.0. Panel

(A) shows the dialog box used for defining variables, and Panel (B) shows the dialog box used for specifying the model,

which is accessed by clicking the “Model” button in the previous dialog box, as identified by the start of the blue arrow in

Panel (A).

test scores for Treatment 2, and one region wherein post-

test scores for Treatment 2 are significantly higher than

post-test scores for Treatment 1, as illustrated by equation

(1). Derivations of each of the terms in the formulae below

are described in subsequent sections.

Simultaneous Regions of Significance (R′)
R′ =

−B ±
√
B2 −AC
A

(1)

where A, B, and C are defined as follows:

A =
−2Fα
N − 4

(ssres)

[
1∑
x21

+
1∑
x22

]
+ (b1 − b2)

2
(2a)

B =
2Fα
N − 4

(ssres)

[
x̄1∑
x21

+
x̄2∑
x22

]
+ (a1 − a2) (b1 − b2)

(2b)

C =
−2Fα
N − 4

(ssres)

[
N

n1n2
+

x̄21∑
x21

+
x̄22∑
x22

]
+ (a1 − a2)2

(2c)

Crossover Point (P )
P =

a1 − a2
b2 − b1

(3)

in which x̄1 and x̄2 are the aptitudemeans for treatments 1
and 2, respectively;

∑
x21 and

∑
x22 are the sum of squares

of the aptitude for treatments 1 and 2, respectively; ssres
is the residual sum of squares from the overall regression

analysis when all terms of the design are included; a1 and
a2 are the intercepts for treatments 1 and 2, respectively;
b1 and b2 are the regression coefficients for treatments 1
and 2, respectively; N is the total number of participants;

n1 and n2 are the number of participants in treatments 1
and 2, respectively; and Fα is the tabled value of F with 2
andN − 4 degrees of freedom at a pre-determined α level.
Methods for obtaining these values are as follows:

x̄1, x̄2,∑x21, and∑x22. The notation x̄1 and x̄2 indicates
the mean of x for treatments 1 and 2, respectively. The no-
tation

∑
x21 and

∑
x22 symbolizes the sum of all squared

x values for treatments 1 and 2, respectively. In the case
of the hypothetical data set, x is the aptitude or pre-test
score, and the two groups are Treatment 1 and Treatment

2. These values are presented in Table 1.

ssres. The notation ssres represents the residual (error)
sum of squares from the overall regression analysis when

all terms of the design are included. Fortunately, an analy-

sis appropriate to obtain this value was already completed
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Table 2 Test for Homogeneity of Regression Slopes Using a General Linear Model in SPSS 23.0

Type III Mean

Source Sum of Squares df Square F p-value
Corrected Model 5573.32 3 1857.77 124.83 < 0.001

Intercept 9019.96 1 9019.96 606.07 < 0.001

Treatment 2406.09 1 2406.09 161.67 < 0.001

Pre-Test Score 3028.40 1 3028.40 203.49 < 0.001

Treatment-by-Pre-Test Score 2123.53 1 2123.53 142.69 < 0.001
a

Error 535.78
b

36 14.88

Total 267578.00 40

Note. a: p-value corresponding to interaction term; if p < α, homogeneity of regression slopes assumption is violated;
b
:ssres.

Table 3 Test for Homogeneity of Regression Slopes Using Regression Analysis in SPSS 23.0

Mean

Model Sum of Squares df Square F p-value
Regression 5573.32 3 1857.77 124.83 < 0.001

Residual 535.78
b

36 14.88

Total 6109.10 39

Standard

Model Coefficient Error t p-value
Constant -28.76 6.65 -4.32 < 0.001

Treatment 54.07 4.25 12.72 < 0.001

Pre-Test Score 1.92 0.12 15.82 < 0.001

Treatment-by-Pre-Test Score -0.92 0.08 -11.95 < 0.001
a

Note. a: p-value corresponding to interaction term; if p < α, homogeneity of regression slopes assumption is violated;
b
: ssres

earlier—that is, when testing for homogeneity of regres-

sion slopes through univariate general linear model anal-

ysis. Recall that “all terms” of the design included the in-

dependent variable (treatment), covariate (pre-test score),

and independent variable-by-covariate (treatment-by-pre-

test score) interaction term, using post-test score as the de-

pendent variable. SPSS, for example, displays this value as

Error Type III Sum of Squares following the general linear

model approach, as shown in Table 2, and as Residual Sum

of Squares following the regression approach, as shown in

Table 3.

a1, a2, b1, and b2. The notation a1 and a2 correspond to
the intercepts from linear regression analyses for treat-

ments 1 and 2, respectively; b1 and b2 represent the re-
gression coefficients for treatments 1 and 2, respectively.

These values, as shown in Table 4, may be obtained by con-

ducting separate linear regression analyses by treatment,

using pre-test score as the independent variable and post-

test score as the dependent variable. In SPSS, for exam-

ple, filter for Treatment 1 cases (i.e., Data>Select Cases;

write “If condition is satisfied” statement, “Treatment =

1”) and then access the regression analysis through Ana-

lyze>Regression>Linear, as shown in Figure 4; repeat the

process filtering for Treatment 2 cases.

N , n1, n2, and Fα Document N (total number of partic-

ipants), and n1 and n2 (number of participants in treat-
ments 1 and 2, respectively). Next, recall that Fα is the
tabled value of F with 2 and N − 4 degrees of freedom
(df ) at a pre-determined α level. These values may be
looked up inF tables typically appearing in the appendices
of statistics textbooks or online at various locations (e.g.,

search in a web browser for “table of critical F values”).

Ensure that the table being viewed corresponds to the α
level specified by the researcher (e.g., α = 0.05). To find
the appropriate F value in the table, note that the value of
2 represents the numerator df , whereas the value ofN − 4
represents the denominator df .
Finally, complete all calculations using the values ob-

tained in the preceding steps. Values derived from the hy-

pothetical data set are as follows:
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Figure 4 Screenshot of the dialog box for performing linear regression analysis in SPSS 23.0.

Table 4 Derivation of a1, a2, b1, and b2 using separate regression analyses by treatment group in SPSS 23.0

Model Coefficient Standard Error t p-value
Treatment 1
Constant 25.31a 3.55 7.13 < 0.001
Pre-Test Score 1.01b 0.07 15.38 < 0.001

Treatment 2
Constant 79.37a 2.28 34.79 < 0.001
Pre-Test Score 0.09b 0.04 2.21 0.04

Note. a: Value represents intercept (a); b: Value represents regression coefficient (b)

x̄1 = 51.95 and x̄2 = 54.30;∑
x21 = 59013 and

∑
x22 = 64062;

ssres = 535.78;

a1 = 25.31 and a2 = 79.37;

b1 = 1.01 and b2 = 0.09;

N = 40;

n1 = 20 and n2 = 20;

F0.05(2,36) = 3.26.

Substituting these values in the Potthoff (1964) formu-

lae presented earlier, it may be found that P = 58.8 and
R′ = 55.4 and 62.2, the temporary variables A, B, and C
having values of 0.8432, −49.5675, and 2903.876, respec-
tively. Therefore, the crossover point of the two regression

lines is 58.8, the value associated with the lower SROS is
55.4, and the value associated with the upper SROS is 62.2.

Re-construct two-group scatterplot to depict and inter-
pret SROS and crossover point
It is helpful to view the SROS and crossover point within

the context of the full data set. The two-group scatterplot

originally constructed to informally assess homogeneity of

regression slopes is well-suited for this purpose. The inser-

tion of shapes and text boxes facilitates the depiction of the

calculations rather easily, as shown in Figure 5.

Interpretations may be best explained by leveraging

the hypothetical data set and related results. In general,

the presence of an ATI effect indicates that treatments had

a differential effect on students’ post-test performance de-

pending upon student aptitude, or pre-test score (Cronbach

& Snow, 1981; Pedhazur & Schmelkin, 1991).

Specifically, calculations completed at this point may

be interpreted as follows, as displayed in Figure 5: (1) at

pre-test scores below 58.8 (crossover point), students in

Treatment 2 tended to score higher on the post-test than

did students in Treatment 1; (2) at pre-test scores above
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Figure 5 Pre-/post-test score scatterplot by treatment with SROS and crossover point noted.

58.8, students in Treatment 1 tended to score higher on

the post-test than did students in Treatment 2; (3) at pre-

test scores below 55.4 (value of lower SROS), students in

Treatment 2 scored significantly higher on the post-test

than did students in Treatment 1; (4) at pre-test scores

above 62.2 (value of upper SROS), students in Treatment

1 scored significantly higher on the post-test than did stu-

dents in Treatment 2; and (5) at pre-test scores occurring

in the range of 55.4-62.2 (also called the “region of insignif-

icance,” D’Alonzo, 2004, p. 808), post-test scores did not

differ significantly between treatments.

Explore outcomes between treatments in each region
of significance
At this stage, researchers and educators may be addition-

ally interested in the magnitude of differences between

treatments occurring in each region of significance, as “sta-

tistically significant” does not always equate to practically

important or educationally meaningful. Depending upon

sample size within each region, a review of descriptive

statistics, mean comparisons, and confidence intervals (CI)

of mean differences may be helpful.

For example, regarding the hypothetical data set, 23

students scored below 55.4 on the pre-test—12 students in

Treatment 1 (post-test mean score = 66.8; SD = 11.5), and

11 students in Treatment 2 (post-test mean score = 83.7;

SD = 4.0). The mean difference was 16.9 (95%CI = [9.4,

24.6], equal variances not assumed, df = 13.84). Thirteen
students scored above 62.2 on the pre-test—6 students in

Treatment 1 (post-test mean score = 97.7; SD = 1.8), and 7

students in Treatment 2 (post-test mean score = 85.0; SD =

1.5). The mean difference was 12.7 (95%CI = [10.7, 14.7],

equal variances assumed, df = 11). Confidence intervals
for these hypothetical data were obtained through inde-

pendent samples t-tests in SPSS.

Discoveries of ATI effects necessitate consideration of

generalizability and, in the context of two-group pre-

post designs, future use of the pre-test (e.g., to iden-

tify optimal treatment assignment). The nature of

ATI effects—indicating that individuals perform differ-

ently under different conditions depending upon apti-

tude—highlights the need to determine resource availabil-

ity (e.g., professionals, space, equipment, and assessment

for the delivery and evaluation of tailored treatments or in-

terventions). Differentiation of treatments, interventions,

instruction, and other services may place greater demands

upon the provider, but the benefits to recipients may make

tailoring the experiences worthwhile.

Conclusion
Two-group pre-post designs may seem simplistic in their

structure; however, the analytical approach to handling

data arising from these designs is critical. Approaches that

are commonly applied to two-group pre-post designs may
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yield markedly different results and interpretations de-

pending upon the nature of the data. For example, return-

ing to the hypothetical data set, (1) if the researcher opted

not to control for pre-test scores (since means were not

significantly different between the two groups, p = 0.65),
an independent samples t-test on post-test scores indicated

no significant between-group differences (p = 0.10, equal
variances not assumed); (2) an independent samples t-

test on the gain or difference scores indicated no signifi-

cant between-group differences (p = 0.23, equal variances

not assumed); (3) mixed RM-ANOVA indicated a significant

main effect of time (p < 0.001), but no significant main
effect of treatment (p = 0.29), or time-by-treatment inter-
action effect (p = 0.23); and (4) ANCOVA indicated no sig-
nificant differences between treatments after controlling

for pre-test scores (p = 0.05). Results from each of these
analyses would leave the researcher concluding that per-

formance does not differ significantly between treatments;

moreover, perhaps observation of the low power associ-

ated with ANCOVA (0.50) would have led the researcher to

instead increase the sample size for a future study trial.

It is important to check for ANCOVA assumptions, and

when heterogeneity of regression slopes occurs, an ATI ef-

fect has been discovered. Accordingly, an alternative ap-

proach to ANCOVA must be sought. Formulae provided by

Potthoff (1964) as a modification to the Johnson-Neyman

procedure (Aiken & West, 1991; D’Alonzo, 2004; Pedhazur

& Schmelkin, 1991; Rogosa, 1981) is one straightforward al-

ternative.

While these steps were expressly formulated to apply

only to two-group pre-post designs, note that methods have

been suggested for handling data from designs that incor-

porate more than two groups (e.g., Potthoff, 1964), more

than one covariate (e.g., Karpman, 1983), and more than

one outcome (e.g., Potthoff, 1964).
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